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SYSTEM SETUP 

Working Environment Preparation

PC/Laptop with Windows/Mac OS X

Google Chrome Web Browser: 

https://www.google.com/intl/en-US_ALL/chrome/

Vaidio server

PoE switch

How to set up Vaidio in your network: 

https://youtu.be/WK820iO4cBk

Default Vaidio IP address: 192.168.100.100

How to change the IP address of your Vaidio server:

Log into Admin Portal: 

192.168.100.100:8000/system

Network > fill out new IP address and Netmask

Return to Table of Contents

https://www.google.com/intl/en-US_ALL/chrome/
https://youtu.be/WK820iO4cBk
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SYSTEM SETUP (CONT.) 

Return to Table of Contents

Check that the Vaidio unit works properly after it has been connected:

1.Login

2.Add camera

3.Search for “person”

4.Set up and receive alert for “person”

To check the system settings and/or upload new software licenses, go to System.

If you have any questions, email support@IronYun.com or your local IronYun

representative.

mailto:support@IronYun.com
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NETWORK CONFIGURATION

Return to Table of Contents
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NVR/DVR
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USER INTERFACE

Return to Table of Contents

Login

User Menu 

Object Types 
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LOGIN 

Return to User Interface

 Login with the default admin 

account and password

 Note: after the first login, we 

recommend changing the Admin 

password for maximum security. 

Record the new password in a safe 

place.

Default “Admin” Password: 

admin888

Reset Password with email

(SMTP setting must be done 

before it works)

Firmware 

Version
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USER MENU  

Return to User Interface

System Management

Analytic Functions

System Configuration

Toggle to expand menu
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Return to User Interface

OBJECT TYPE 

Animal

PersonVehicle
Object
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CAMERA MANAGEMENT 

Return to Table of Contents

Add New Camera

Camera Authentication 

Add Axis Camera 

Select AI Model 

Configure Camera Profile

Define General Region of Interest

Activate AI Engine & ROI 

Camera Health Management 

GPS

Indoor Map  



115/26/2022 © 2022 IronYun USA Inc. - Confidential

ADD NEW CAMERA 

Return to Camera Management

Preview to check the 

connection

Note: If Camera APP 

is selected as the 

camera type, Preview 

is not supported 

To have video playback of the camera stream, 

make sure to link the NVR to the camera (add 

NVR to Vaidio first to have it available in the 

dropdown list)

Support 5 types of 

camera source inputs:

1.Camera IP Address

2.RTSP

3.Camera APP

4.External

5.Video File

(For types 3-5. refer to 

the next slide)

Input camera info and 

URL to receive 

camera live steaming



125/26/2022 © 2022 IronYun USA Inc. - Confidential

ADD NEW CAMERA (CONT.)  

Return to Camera Management

Video File: Select the video file in the file list (the file 

must be uploaded to appear in the list, see Upload 

Video) and set it to play once or loop. The video file 

will appear as a live stream for real-time analysis and 

search.

External: To connect the camera from the 3
rd

-party 

VMS system. External alerts via API may be used to 

develop plug-ins into Vaidio

Mapping ID must be identical to 

the ID on the Vaidio Cam.

Camera APP:

Download Vaidio Cam app on 

a smartphone. Connect Vaidio

to Vaidio Cam to turn the 

mobile camera into a live 

camera and analyze the video 

stream in real time. 

(Note: the video streaming 

from Vaidio Cam can only 

perform FR and LPR analytics.)

https://docs.google.com/presentation/d/1EvEjIs4SE94YmBkWRYmysHJFjk59M2eb/edit#slide=id.p29
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ADD AXIS CAMERA

Return to Camera Management

Add camera using RTSP (circumvent 

time/date sync issue):

Different camera models may have 

different RTSP stream outputs

Example RTSP output: 

rtsp://ipaddress/onvif-

media/media.amp?profile=profile_1_h

264&sessiontimeout=60&streamtype=

unicast

Add camera using IP Address / Domain name:

1. Make sure to have an ONVIF user created on the 

Axis camera and use that login on Vaidio

2. Disable “Replay Attack Protection” on the camera by 

going to System > Plain config > Web Service and 

uncheck the box. The User can do this temporarily to 

check whether the time is an issue.

3. Update the firmware to their latest version 

9.80.2.2: https://www.axis.com/en-

us/download/bin/15381#axis_destination=/en-

us/products/axis-q6125-le/support-and-

documentation

https://www.axis.com/en-us/download/bin/15381#axis_destination=/en-us/products/axis-q6125-le/support-and-documentation
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SELECT AI MODEL 

Return to Camera Management

In Camera > Edit > Advanced > AI Model, 

select the needed model(s) from the 

dropdown list for this particular camera

The model selected determines the object 

type(s) available for detection

By default, the General model (30+ object 

types) is selected – most commonly used

The models available to select in the list are 

models installed and activated for this Vaidio

server (check System > AI Models to see 

which model(s) have been installed and 

selected). Contact IronYun if the model you 

need has not been installed.
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CONFIGURE CAMERA PROFILE

Return to Camera Management

In the Object Type tab, make sure to 

select the object types to detect. 

Adjust Confidence and Min/Max 

pixel size per object to get 

more/fewer detections if necessary 

(lower Confidence + smaller Min 

size = more detection, may increase 

false detection rate)

In the Video Search tab, 

adjust Motion Detection 

Sensitivity (MDS) as necessary: 

Higher MDS value = Lower 

sensitivity level = higher 

certainty + fewer false 

positive

(Increase MDS value to 0.3-

0.5 to decrease false positive)

In the FR tab (only appear if Face 

Recognition is activated in AI 

Engines), adjust Face Recognition 

Similarity as necessary: Only the 

similarity of the result higher than 

the value will appear in the 

Dashboard and History.
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DEFINE GENERAL REGION OF INTEREST

Return to Camera Management

Make sure to exclude all irrelevant 

areas in the General ROI (region of 

interest); i.e., the camera’s effective 

FOV, to avoid wasting computing 

resources and eliminate false alarms in 

those areas. 

Use the Pencil icon in the ROI tab to 

draw the area of interest for the entire 

camera. 

Note: the General ROI applies to ALL 

analytics for this camera. The ROIs of 

other analytics (e.g., Intrusion, FR) 

should be within the General ROI.  No 

objects outside of the General ROI will 

be detected, even if it is in the ROI of 

other AI engines and that ROI is outside 

of the General ROI.    
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ACTIVATE AI ENGINE(S) & ROI 

Return to Camera Management

Select/Activate one or multiple 

AI Engines (analytic functions) 

– Video Search is always 

included by default.

Draw the Region of Interest (ROI) 

of Intrusion in the camera 

preview. The ROI can have any 

irregular shape.

Draw the Counting Line of 

People Counting in the 

camera preview scene and 

define the in/out direction. 

Define the target object 

type to detect. The user 

can adjust the sensitivity 

if needed.
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CAMERA HEALTH MANAGEMENT

Return to Camera Management

Normal camera view

Abnormal camera status 

(poor resolution, obstructed 

view, etc.)

Video Camera icon under Abnormal 

Check indicates which camera currently 

has an abnormal status

Set this camera view as 

normal to avoid future alert

Red alert icon indicates 

camera abnormality



195/26/2022 © 2022 IronYun USA Inc. - Confidential

CAMERA HEALTH MANAGEMENT (CONT.) 

Return to Camera Management

Click on Timetable icon to 

schedule when to check the 

camera status

Click on each rectangle to 

view a snapshot of the 

camera FOV at that hour

Click on Clock icon to view 

the camera status history 

(up to 30 days, 24h/day)
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ADD GPS TO THE CAMERA 

Return to Camera Management

In Add Camera, select GPS Map as the 

Location Type, and click the location 

icon to pin the exact coordinate of the 

camera on the map
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RESULTS ON GPS MAP 

Return to Camera Management

Click the location icon; the 

search result will show its exact 

location on map with the number 

of the detected events.
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ADD INDOOR MAP 

Return to Camera Management

If a camera is an indoor camera, to 

define its location in the building, go to 

Indoor Map in Camera tab to add an 

indoor map to the database.

Input location name and setup the GPS 

map.

Upload Floor Plan. The users can 

upload multiple floor plans to the 

same location (e.g., different floor 

plans of one building)

If a camera is an indoor camera, to 

define its location in the building, go to 

Indoor Map in Camera tab to add an 

indoor map to the database.

Input location name and setup the GPS 

map.

Upload Floor Plan. The users can 

upload multiple floor plans to the 

same location (e.g., different floor 

plans of one building)
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ADD INDOOR MAP TO THE CAMERA

Return to Camera Management

In Add Camera, select Indoor 

Map as the Location Type, and 

click the map icon to choose the 

Indoor Map.

Click the location icon to locate 

the camera in the floor plan. 

▪ Hover over the camera icon, 

and click to rotate the 

direction 

of the camera icon.
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RESULT ON INDOOR MAP 

Return to Camera Management

Click the map icon and select the floor plan. The 

search result will show the exact location of the 

detected object/event on the floor plan with the 

number of detected events.
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NVR MANAGEMENT 

Return to Table of Contents

Add NVR 

Internal Video Recording
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ADD NVR

Return to NVR Management

In the NVR tab, go to Add NVR. Input 

the requested information and select 

the NVR Brand under the list.

Reason to connect NVR to Vaidio: 

• Have video playback for detected 

events

• Retrieve and apply analytics to 

recorded videos in NVR 
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INTERNAL VIDEO RECORDING

Starting from version 5.2.0, 

Vaidio user has the option 

to record video within the 

Vaidio server. User can 

check the number of 

channels in System > 

License

Return to NVR Management
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INTERNAL VIDEO RECORDING (CONT.)

Internal NVR is the default in 

the NVR page, and cannot be 

edited or deleted.

User can add/delete external 

NVR(s) to Vaidio as usual.

To process old recorded videos, 

user can select File > Retrieve 

Video > Internal NVR and Channel 

ID 

Internal video file supports audio.

Return to NVR Management
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INTERNAL VIDEO RECORDING (CONT.) 

Internal NVR is only allowed for 

camera with IP Address and/or 

RTSP

To enable video playback and record video 

for a particular camera in Vaidio, user can 

select Internal under NVR in the camera 

configuration.

User can turn on internal video recording 

for individual cameras, i.e., not all cameras 

connected to Vaidio must record video in 

Vaidio.

Delete recorded video via API 

Advanced users may delete the recorded 

video segment from the internal recorder 

through the database. 

Return to NVR Management



305/26/2022 © 2022 IronYun USA Inc. - Confidential

FILE MANAGEMENT 

Return to Table of Contents

Upload Video 

Retrieve Video 
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UPLOAD VIDEO 

Return to File Management

Select video file from 

the local device

Define start date & time to 

match the system timeline for 

indexing

Check Profile to activate the correct 

object types to be detected.

Activate FR/LPR/PPE if needed (Object 

Detection / Video Search is enabled 

by default.)

Support file formats: H.264, 

MJPEG, MPEG1, MPEG2, 

MPEG4, VC1, VP8, VP9
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RETRIEVE VIDEO

Return to File Management

Select the preconfigured NVR and 

channel to retrieve and download the 

correct video file

Check Profile to activate the 

correct object types to be detected.

Activate FR/LPR/PPE if needed 

(Object Detection / Video Search 

is enabled by default.)



335/26/2022 © 2022 IronYun USA Inc. - Confidential

USER MANAGEMENT 

Return to Table of Contents

Types of User Accounts

Add User  

Add User Group & Permission Control  

AI Engine Control 
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TYPES OF USER ACCOUNTS 

Return to User Management

Capability
Permission

Admin Co-Admin General User

Adding/deleting users Manage Manage (except Admin) None

User’s role and group Manage Manage None

User’s password and email Manage Manage (except Admin) Manage its own only

Camera control Manage Manage Based on group permission

Video source control Manage Manage Based on group permission

AI engines control Manage Manage Based on group permission

Configuration control Manage Manage Based on group permission

Note: Having Co-Admins makes it easier to manage the platform and track user activities. Instead of relying on one admin 

account, Admin can create multiple Co-Admin accounts to manage the system and other user groups. 
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ADD USER 

Return to User Management

In the User tab, go to Add 

User, input the user info, and 

assign the password for the 

user. Select the User Group 

for the user or assign later in 

User Group Setting. 

(Default: Undefined)

Note: User accounts in the 

Undefined group do not have 

access to any function and 

cannot log into Vaidio.

To add Co-Admin, select 

Admin.
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ADD USER GROUP 

Return to User Management

In the User Group tab, go 

to Add Group. 

Input the name of the User Group, 

assign and add the users to the 

group in the User tab.
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PERMISSION CONTROL 

Return to User Management

 Camera control: select the cameras that 

the user group can access

 Video source control: select the video 

source from which the user group can 

upload videos

 AI engine control

 Configuration control: select whether the 

user group can Add new cameras, Manage 

alerts, and/or Unblur faces/people if 

System > Setting > Privacy Protection 

is ON 
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PERMISSION CONTROL (CONT.)

For Camera Control, start 

by typing the name of the 

camera to assign 

permission into the Search 

bar

For Permission Control, amin may 

add [none] permission and more 

restrictions to camera 

management

Video Sources come from the setting 

of the upload file. 

In the Permission tab, search and select Cameras and 

Video Sources for this group of user to access, then 

assign the level of the authority (View or Manage) to 

each source and AI Engines.

Return to User Management
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AI ENGINE CONTROL 

Return to Camera Management

 Permission: None, View, Manage

 None: user group with “None” permission cannot 

see the tabs of these engines in the left side menu 

and cannot see the engine configuration tabs in 

Camera configuration

 Engines with None permission: FR, LPR, IDV (for 

privacy protection)
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ALERT SETUP

Return to Table of Contents

Add New Alert 

Alert Types

Trigger Actions 

Dashboard – Real-time Alert 

Alert History 
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ADD NEW ALERT 

Return to Alert Setup

Select the Alert Type and 

corresponding rules with the 

specific object type and scenarios 

to be detected.

Include:

- List for FR/LPR

- ROIs for ID

- Denied or Granted for IDV 

(Identity Verification)

- Occupancy for PVC

Select the time period to activate the alert.

Select the Trigger Action. The alert can be shown in  

Vaidio alert dashboard, Vaidio app notification, 3
rd

-

party VMS system or email.

The alert can also be sent via HTTP push to other 

devices, e.g., I/O device for access control.
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ALERT TYPE

Return to Alert Setup

Types of Alerts:

1.Camera Abnormal

2.Video Search: allow all combinations of object types + attribute (color, quantity, 

etc.). The entire FOV is the region of interest (ROI)

• Can set alert for crowding using person > n

3.Intrusion: similar to Video Search with higher fps, more ROIs, exclusion zone

4.FR & LPR: set alert for any list and/or Not in list (for unidentified person/vehicle)

5.Identity Verification

6.People/Vehicle Counting

7.Person/Vehicle Wrong Direction

8.Person Falling

9.Loitering & Illegal Parking

10.Object Left Behind

11.Speeding: set in Video Search alert type for vehicle moving above/below/at 

average speed of traffic

For alert types 3-11, must enable AI 

engines for the camera (Camera > 

Edit > Advanced) before adding new 

alert (Alert > Alert Rule > New Alert)

For alert type 11, must enable 

Vehicle Counting for the camera

For alert types 3-7 and 9-11: must 

configure the region of interest (ROI) 

(types 3, 4, 5, 9, 10) or line with 

direction (types 6, 7, 11) of each AI 

engine independently (Camera > Edit 

> Advanced) before adding a new 

alert
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TRIGGER ACTIONS

Return to Alert Setup

Types of Trigger Actions

1. Email Notification:

• Can add up to 3 emails

• Add email server at System > Notification > Email to receive 

notification (e.g., for Gmail server, use smtp.gmail.com, port 
465, secure connection SSL)

2. HTTP: to connect to VMS (e.g., Nx VMS) and other systems 

(e.g., gate closing)

3. Alerts in VMS: Axis; BTX Bridge to Milestone XProtect; Digital 

Watchdog; Genetec; Immix; Luxriot; Network Optix; Ocularis; 

Salient

5. APP Notification:

•download Vaidio app (available for iPhone and Android)

•add IP address of Vaidio unit in Server Address

•Connection type: HTTP
Click to view metadata tags available to 

add to email notification or sent in HTTP 

URL or HTTP content.
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TRIGGER ACTION (CONT.) 

Return to Alert Setup

The example of trigger actions:

Email Notification: supports ROI and 

Metadata in source images:

Select as the Trigger Action, then add 

{alertImageMetadataJpg} in the 

description.

The metadata includes Analytics Type, 

Alert Name, and Scene Detail, such as 

the detected object type, license plate 

number and list, face name and list, etc.

Supported parameters for HTTP 

trigger:

[cameraID]

[cameraName]

[startTime]

[endTime]

[eventTimeStamp]

[licensePlateNumber]

[sceneID]
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 Examples of trigger action via HTTP:

 Access control based on Face Recognition of employees: 

https://youtu.be/ILQ6i0RUK6M

 Access control based on PPE (personal protective equipment) detection:

https://youtu.be/LJZmJS7DbaQ

 Example I/O device:  4-port device to control 4 doors

https://www.axis.com/products/axis-p8221

TRIGGER ACTION (CONT.)

Return to Alert Setup

https://youtu.be/ILQ6i0RUK6M
https://youtu.be/LJZmJS7DbaQ
https://www.axis.com/products/axis-p8221
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ALERT DASHBOARD 

Return to Alert Setup

Result on the 

indoor map

Show the exact location of 

the detected event on GPS 

map.

Select specific or multiple alert 

rules to show on the dashboard.
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ALERT HISTORY 

Check to delete the 

history event if 

needed 

Click the Pin to 

display on the map

Select the alert rule and 

adjust the time period to 

search for an event

Return to Alert Setup
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VIDEO SEARCH 

Return to Table of Contents

Dashboard
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VIDEO SEARCH DASHBOARD 

Return to Video Search 

Click on icons of object category to 

search for certain object types & their 

attributes. 

The categories are (from left): Vehicle, 

People, Animal, and All Other Objects 

(e.g., backpack, cell phone)

Click on Camera icon to 

select/deselect cameras to 

search; click on File icon to 

search in uploaded files

❑ Default: Search through all 

cameras (live streams)

Adjust the time period to do search.

• To search from files, the uploaded 

day/time of the selected file should 

be within the selected time period

• Make sure that the correct time 

zone has been set in System > 

Time and synced with the 

camera/NVR (if connected)

Click on the thumbnail 

to see the detail 

information of the 

detected event
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SYSTEM CONFIGURATION 

Return to Table of Contents

Setting

AI Model 

Utility

Time

Storage

License
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TIME 

Return to System Configuration

Time zone selection
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STORAGE 

Return to System Configuration

Data retention time:

• Toggle OFF: data will be saved as long as 

storage has not reached 80% capacity. 

Once the 80% limit has been reached, the 

oldest data are removed first.

• Toggle ON:

• If the retention time is reached before 

the 80% limit, data older than the 

retention time are removed  

• If the 80% limit is reached before the 

retention time, oldest data are removed 

until the usage is below 80%
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LICENSE

Return to System Configuration

Steps to renew license.

In Step 1: Send information file 

(.info) to your IronYun

representative to receive the 

new license key

License/appliance 

specifics
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SETTING – OVERVIEW OF PARAMETERS

Return to System Configuration

Role of the current Vaidio server

Video: 

Video playback length

Drop corrupted frames (Default: ON)

Object tracking mode ON/OFF (Default: 

OFF)

Live stream analytics: disable to run 

analytics on files only (Default: ON)

Sound & loop times of Intrusion notifications & 

Alerts

License plate format for LPR (Default: empty)

Theme selection: light/dark

Privacy protection (blurring people and faces)

Camera connection retry interval

Retention time of Log and Audit Trail

Reset time (to start a new day from 0 count) for People & 

Vehicle Counting

Number of search results displayed (Note: all search results 

are saved as long as there is disk space available, 

regardless of the number of results displayed)

GPS Map ON/OFF

API Basic Authentication ON/OFF (Default: OFF)

SSL Certificate



555/26/2022 © 2022 IronYun USA Inc. - Confidential

SETTING (CONT.)

Return to System Configuration

Select the role of the current Vaidio

server:

• Default: Standalone

• Main: can access all units including 

Main and Remotes

• Remote: is only accessible via Main

Input the license plate pattern to be 

detected as appropriate for the 

region. E.g., “AAA?999” for license 

plates that must contain 3 letters in 

the beginning, a miscellaneous 

character in the middle, and 3 

numbers at the end

Toggle ON/OFF the 

Object Tracking Mode 

to enable object 

tracking in Live View

Configure the video clip 

playback duration for 

video analytic events
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SETTING (CONT.) VAIDIO ROLE

Return to System Configuration

☐ Some functions will be hidden and disabled in Remote and Standalone

☐ Remote can only access System

☐ User can add cameras, activate analytics and view detection results for 

Remote via Main. User cannot access analytics or cameras from Remote.

Vaidio Page Vaidio Filter Edit FR List Edit LPR List Indoor Map

Standalone X X O O O

Main O O O O O

Remote X X X X X
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SETTING (CONT.) PRIVACY PROTECTION & GPS MAP 

Return to System Configuration

Toggle ON/OFF to implement Privacy 

Protection (blur people and faces in 

displayed detection)

Toggle ON/OFF to implement GPS map 

(must be connected to the internet)
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PRIVACY PROTECTION 

Return to System Configuration

 When Privacy Protection is ON, all detected person/face are blurred in 

search & alert results for all cameras activated in the server:

 Blurred detail page, thumbnails, exported data thumbnails

 Restrictions: no video playback, no video download, no live view

 Blurring is applied right after analysis, and images processed before

turning on Privacy Protection cannot be blurred. 

 Admin and user with Privacy Protection - Unblur permission can 

Unblur Face in the detail page

 Once the icon is clicked to Unblur, all blurred people/faces are 

unblurred

 With Privacy Protection, the system needs double storage (refer to the 

Storage Calculator in the portal)

 Compatible AI models: General model, Power model 2.2 and higher

 Turning ON Privacy Protection will restart the system

Click to blur/unblur in the 

detail page
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AI MODEL 

Return to System Configuration

Click on the number to view 

the detectable object types in 

each AI model

Switch / Upload AI Model to 

apply different object types to all 

analytics functions in Vaidio.

AI model determines which object type can be detected

Use the Replace button to upgrade the model and keep 

all settings in cameras.

Changing the model by Upload and activating it (instead 

of by using the Replace button) will erase ALL settings in 

the cameras. 

The replaced AI model must include all object types of the 

AI model being replaced.
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 Default model:

 Vaidio 5.4.0 and later: Power Model

 Vaidio 5.3.0 and earlier: General PRO 4.0 model

 The default model can support all analytics functions. Other models 

may not support certain analytic functions and object types, e.g., 

Weapon Model does not support LPR.

 Contact your local IronYun representative for more details on which 

model to use.

AI MODEL (CONT.)

Return to System Configuration
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UTILITY 

Return to System Configuration

Diagnosis tool for 

network analysis

Methods available:

Ping

Traceroute

NS Lookup
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ADMIN PORTAL 

Return to Table of Contents

Admin Portal Login

Network

Upgrade
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ADMIN PORTAL LOGIN 

Return to Admin Portal 

Log into the admin portal using the IP address of the Vaidio server of interest, port 8000, 

and the server’s admin username & password

Example:

https://192.168.100.100:8000

Purpose:

To change admin password (recommended after first login for maximal security)

To set time zone of Vaidio server and synchronize with NTP server

To configure network connection

To perform software upgrade 
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NETWORK 

Return to Admin Portal 

Interface: hardware-dependent. User only needs to 

select the interface to change the IP address or add 

an IP address

Mode: 

DHCP

Static configuration

Add DNS server if necessary
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UPGRADE

Return to Admin Portal 

Offline upgrade

Contact IronYun representative and support team to 

obtain the upgrade file (13+ GB). Internet is only 

required to download the file to your local drive.

Upgrade the admin portal (Step 1) and the main 

Vaidio system (Step 2) in the local network (no internet 

is required).

Online upgrade

MUST have Internet connection to check for update 

and download the upgrade file into the local main 

Vaidio server

Upgrade the admin portal (Step 1) and the main 

Vaidio system (Step 2) using the Internet
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